Using PowerTeacher Pro

Working with Grades

When entering scores, make sure to use the type of score that you
set up when you created the assignment. For example, use
numbers for points and percentages or letters for letter grades.

To enter scores:
1. Click Grading
2. Click Assignment List or Scoresheet

3. From the Assignments or Scoresheet pages, enter a
student’s assignment score by clicking in the cell where the
student’s name intersects with the assignment name and
type in the score

View the summary above the list of assignments to see the
selected assignment’s score type, as well as the student’s
existing score (if the assignment was previously scored),
and the due date. In the summary, click Edit Assignment
to edit the assignment details. Click Show More to view
additional information, such as the associated grade and
special codes scales.

Assignment: Pages 15-16

Score Type: Points (100) Score: B+ | 89% | 89/100 Due: 1/4/2016

Using the Score Inspector and Score Indicators

While you can enter scores manually, use the Score Inspector to
provide more details about the student’s performance, such as
when a student has a missing or late assignment. Also use the
Score Inspector to enter a comment about a student’s score.

Your district leaders may have associated a special codes scale to
the regular grade scale. If that is the case, you can click Codes in
the Score Inspector and select a special code, such as INC, to
score a student’s assignment. In some cases, you may also see

other system-generated icons that are related to standards grades.

To open the Score Inspector, click in a score cell on the
Assignments or Scoresheet pages.

The following table provides brief explanations of the score
indicators and other icons available in the gradebook.

BN

Indicator or

Description
lcon

Indicates that an assignment was collected

Indicates that an assignment is late

Late

Indicates that an assignment is missing

Indicates that an assignment is exempt

Indicates that an assignment wasn’t completed
due to the student being absent

Indicates that an assignment is incomplete
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Indicator or

Description
lcon

Indicates that a comment was added

=

Indicates that evidence exists for mastery that
may differ from a student’s calculated standard

score
Indicates that the standard grade is auto-
G calculated from the lower-level standards scores

auto-calculate the scores for the standards

Indicates that the assignment score is used to
a aligned to the assignment

Filling Scores

Use the Fill Scores functions to either fill scores for one assignment
for all of the students in a class, or to fill all assignment scores for
one student. Scores will be filled in cells that do not already have
scores. Additionally, use the fill scores functions to fill comments.

To fill students’ scores for one assignment:

1. For the selected assignment, click in a score cell on the
Assignments or Scoresheet pages

2. Enter the score or select the score indicator in the Score
Inspector

3. Click the Fill icon with the vertical arrows
4. Click Save

To fill multiple assignment scores for one student:

1. For the selected student, click in a score cell on the
Assignments or Scoresheet pages

2. Enter the score or select the score indicator in the Score
Inspector

Click the Fill icon with the horizontal arrows

4. Click Save

Adding Comments

As you enter scores or indicators for assignments, use comments
to record specific details about student performance. Add
comments manually or choose comments from the comment bank.
Click the star next to a comment in the bank to set it as one of
your favorite comments. Include smart text, such as <first name>
or <he/she>, to personalize comments.

To add a comment:
1. Click the Comment icon in the Score Inspector
2. Either enter a comment in the text box, or click Comment
Bank and select a comment
A blue Comment icon appears in the student’s score cell.
3. Click Save

4. Click the icon to read the comment

STUDENTS(25) COURSE GRADE Pr1-4Kp15... Equ. Fracti..
e 1. AYALA, Frank A- 91% 2081.65... 89 95
_ =]
‘ 2. BAILEY, MacDonald c 76% 1704.7/... 69 79
=
0 3. BERGER, Harvey A- 90% 1872.75... 95 89
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Marking Assignments

Use one of two methods to score an assignment—score a single
assignment from the Assignments page, or score multiple
assignments on the Scoresheet.

To enter scores, score indicators, or comments for a single
assignment:

1. Click Grading

2. Select Assignment List

3. Click the name of an assignment

4. Click in a student’s score cell and type a score, such as 72
View the assignment summary above the list of students to
see which score type to use.

5. Click the Comment icon in the Score Inspector

6. Enter a comment, such as Needs to turn work in on
time

7. Click the right-facing Score arrow in the Score Inspector to
move to a standards score cell (if standards are aligned to
the assignment)

8. Enter a standards score for the student
View the assignment summary above the list of students to
see which grade scale type to use.

9. Click Save

To enter scores, score indicators, or comments for one or more
assignments on the Scoresheet:

1. Click Grading
2. Select Scoresheet

3. Click in a student’s blank score cell for the selected
assignment and enter a score in the Score Inspector

4. Click the vertical Fill icon to fill all of the blank score cells
with the score you entered in the Score Inspector

5. In the alert window that lists the number of scores that
were filled, click Ok

6. Click in a different student’s score cell for a different
assignment and click the Exempt score indicator

7. Click Save

When you delete or edit a score, the values in the student’s Course
Grade column are grayed out because they are being edited. Once
you click Save, the student’s grades will be recalculated using the
new score.

Working with Final Grades

Final grades are updated automatically throughout the term as you
enter assignment scores in the gradebook. When the term comes
to a close, however, you may have additional tasks to perform
before submitting grades for report cards to make sure that your
final grades are accurate. For example, you may have to enter
standards grades and modify individual scores. Occasionally, you
may also need to modify a student’s final grade in a course based
on effort, participation, or other performance factors.

To work with final grades, click Grading and use the links in the
Grades section. Access the same links through the Quick Menu—
the arrow next to the heading at the top of the grading pages.
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Grades: Traditional - S1 ~

Areas
I Traditional

Standards

To modify a final grade:

1. Click Grading

2. Click Traditional

3. Click a student’s final grade

4. In the Score Inspector, edit the student’s grade
For example, change a letter grade of A- to A, and a
percentage of 91 to 94.

5. Click Save
Notice that the student’s final grade cell has a small triangle

in the upper-left corner, which indicates that the grade has
been modified manually.

A 94% 2081.65...

6. Open the Quick Menu and select Standards

7. Click a standards grade for the same student and edit it

For example, change a score of 3 to 4.
Click Save

To revert to the calculated grade, click the Undo icon in the
score inspector.

Recalculating Final Grades

Although final grades in PowerTeacher Pro are calculated
automatically, you can force a recalculation, if necessary. Use the
recalculate tool after making significant changes in the gradebook,
such as adding multiple assignment scores for students who
transferred from another class. Also, recalculate grades when your
PowerSchool administrator changes a setting that affects the
gradebook, such as the grade calculation formula.

To use the recalculate tool:

1.

2
3.
4

Click Settings
Select Recalculate Final Grades
Select the classes in which you are recalculating grades

To recalculate traditional grades, check Traditional Final
Grades

To recalculate standards scores, check Standards Final
Grades

Click Recalculate
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Analyzing Performance

Use the gradebook to analyze student performance at any time
during the school year. Analyze performance throughout the term
to ensure that students are mastering the skills and standards that
you are teaching. Review students’ performance as you prepare to
complete final grades for report cards, and then use the gradebook
to prepare for and conduct parent-teacher conferences.

Review how students in an entire class are performing using the
Progress pages. The individual student pages provide helpful
information during parent-teacher conferences to explain why a
student earned a particular grade.

Viewing Individual Student Progress
To review an individual student’s performance:
1. At the top of the gradebook window, select a class
2. Click Students
3. To view the first student’s performance, click Assignments

4. Review the student’s course grades and individual
assignment scores, then open the Quick Menu and select
Standards Progress

5. Review the student’s standards scores for each reporting
term, then click the Assignments icon for one of the
standards

6. Review the graph of standards scores, then click Show
Metrics to review the student’s other standards statistics

7. Click Students and select a different student to view his or
her Standards Progress page

Here are the definitions of the standards scores statistics that are
visible when you click Show Metrics below the graph:

+ Most Recent — The average of the most recent score(s)
« Mean — The mathematical average of the scores

+ Median — The middle of the scores (half of the scores are
above this number and half are below)

» Mode — The most common score achieved

« Weighted Mean — The average of the scores based on the
average of total weighted points

+ Highest — The highest score

These statistical values are indicators of how well the student did
on a specific standard. If any of the values are low, it may mean
that the student needs additional practice on the skill or concept
that you're assessing, or you may need to revise the assignment.
To view the student’s performance on additional standards, open
the Quick Menu and select a standard.
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The orange Professional Judgment Indicator may appear next to a
student’s standard score on the Standards Progress page when
evidence exists for mastery that may differ from the student’s
calculated standard score. To evaluate the student’s level of
mastery, click the Assignments icon next to the standard score.

i SPEARS, Armstrong - Standards Progress
1(A-B) Calculus
MAT.H.AG Bullging Functions - (Comment Only)

Grade Scale Type: Numeric (1 - 4)
STANDARDS Q S Q ASSIGNMENT

MATH.10.AG Graph polynomial functions 2 1+ 2- 2- 6 E

Use your professional judgment to evaluate whether or not the
calculated score is a true indication of the student’s level of
mastery. For example, if the student was ill or had a bad test day,
his last score may not be a true indicator of his skill level, so you
could choose to ignore that score and change the calculated score
from a 2- to a 2.

Standards Progress / SPEARS, Armstrong - 1(A-B) Calculus

- = Calculated : Most Recent 3

Standard Grade

Show Metrics

O

Analyzing Class Progress

To analyze the performance of an entire class, begin by selecting
the class at the top of the gradebook window. Then, click
Progress. Depending on how the gradebook is set up, you can
view class progress on traditional grades and standards grades.

Viewing Traditional Grades Progress

To view traditional grades progress:

1.

From the Progress menu, select Traditional

The graph on the Traditional Grades Progress page shows
the distribution of grades for the class for the selected
reporting term. To the right of the graph, view a summary
of the total number of students who have missing, late, or
incomplete assignments.

Calculus (Q3)

2 B 24
10 ?

° [+ incomplets |
L7 o

Click the graph to open the Traditional Grades Distribution
window

On the left side of the Traditional Grades Distribution
window, view the score distribution for each reporting term
in the school year
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On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
grade is trending down between the selected terms. A green
arrow indicates an upward trend, while no arrow indicates
no change. You can see which students are performing
better or worse between terms.

To compare trends between a different selection of
subsequent terms, click a term in the Score Distribution
column

To close the window, click X in the upper-right corner

Traditional Grades Distribution & x
’ Calculus
Class grade trends in Q3 compared against Q2

SLOAN, Matt D+ T D

RANDOLPH, Frank C

u

Q2 E i POOLE, Brent c :
u
v

SPEARS, Armstrong c

s1 BAILEY, MacDonald Cc C

WADE, Ortiz

F 1 KAISER, Harvey Cc C
COBS, Hunter B 4 B
‘ 0
Q4
‘ 0 CASE, Shaniqua B 4 B

Viewing Standards Grades Progress

To view standards grades progress:

1.

From the Progress menu, select Standards

The graph on the Standards Progress page shows the
distribution of grades for each standard aligned to the
course, for the selected class and reporting term.

Calculus

STANDARDS GRADE DISTRIBUTION (Q3) ASSIGNMENTS
MAT.H.10.AG - Graph polynomial functions 22 3 r'." 6 a
MAT.H.11.AG - (+) Graph rational functions 23 2 g 5 B
MAT.H.12.AG - Graph exponential and logarithmic functions 22 - | [ ‘ 4 B
MAT.H.15.AG - (+) Represent a system of linear equations as a single matrix [ 24 1 a 4 E
equation

MAT.H.16.AG - (+) Find inverse of a matrix and use it to solve systems of 20 5 [ ,,‘ 4 B

linear equations

Click the graph to open the Standard Grades Distribution
window

On the left side of the Standard Grades Distribution window,
view the score distribution for the selected standard for
each reporting term in the school year

On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

A red arrow in the Grade column indicates that the student’s
level of mastery is trending down between the selected
terms. A green arrow indicates an upward trend, while no
arrow indicates no change.

To compare trends between a different selection of
subsequent terms, click a term in the Score Distribution
column
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6. To close the window, click X in the upper-right corner

Standard Grades Distribution & x
Calculus
MAT.H.15.AG - (+) Represent a system of linear equations as a single matrix equation
Standard grade trends in Q3 compared against Q2
Q1 23 2 | SLOAN, Matt F 4 D
Q2 24 1 RANDOLPH, Frank Cc 3 B
\ SPEARS, Armstrong C 4 B
s1 24 1
KAISER, Harvey C+ T C
Q3 24 1
WADE, Ortiz Ce J B
Q4 0 0
NOVAK, Layla B ™ C+
s2 24 1 POOLE, Brent B B
- 24 1 POTTER, Romy B S
BAILEY, MacDonald B- 1 C+
| CASE, Shaniqua B T c

On the right side of the Standards Progress page, the number in
the Assignments column indicates the number of assignments that
you've used to give students opportunities to practice the standard
or to assess their levels of mastery.

To view the assignments aligned to a standard:

1. Click the Assignments icon next to a standard

STANDARDS GRADE DISTRIBUTION (Q3) ASSIGNMENTS

MAT.H.10.AG - Graph polynomial functions 21 4 Z] o B

2. On the Standards Assignment Trend window, click the name
of an assignment

3. If needed, edit students’ scores in the column for the
selected standard and click Save

Running PowerTeacher Pro Reports

The gradebook contains reports that you can view onscreen or
print. Personalize each report by entering a custom title or by
including a top note, bottom note, or signature line. The following
table provides brief descriptions of the reports:

Report Name Description

Individual Student « Use this report to view or print a
Report summary of the class activity per
student

+ Present a summary of student
work to parents at conferences or
to a principal during a review, or
use the report as a midterm
update for students and parents

« Choose whether or not to include
course grades and attendance,
assignments, category totals, and
comments

e Print the report for a few students
or a group
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Report Name

Description

Multi-Function
Assignment Report

Use this report to view or print a
list of students and scores per
assignment

Use it to find missing, late, or
incomplete assignments, to help
students and parents keep up with
class work, to target students who
need extra help, or to gauge
which assignments present the
most challenges to students

Student Roster

Use this report to view or print
demographic information by class

Use the report, for example, to
keep track of money collected for
classroom field trips, or as an
emergency contact list

Customize the report by adding
blank columns (the report
remembers the information you
entered last)

Use the Order arrows to arrange
the columns in any order

To run the Individual Student Report:

1. Click Reports

2. Select Individual Student Report

3. Enter a report title, such as Progress Report

4. Open the Select Classes menu and choose the classes to
include on the report

10.

11
12

13.
14.

15.
16.

17.

To run the report for a selection of students rather than for
all of the students in the classes, click Add/ Remove
Students

All of the students are selected by default, so clear the
check box to the right of the Filter area, then in the list of
students, check the boxes next to individual student’s
names

In the Sort Options section, open the Layout menu and
choose By Section, By Student

To sort the report by students’ last names, open the
Students menu and choose Last Name

Verify that Show Percentages is selected to include
students’ grade percentages in the report

Open the Data To Include menu and check Course Grade
Comments and Assignment Comments to include any
comments that you've entered about the students in the
report

"Course Grades and Attendance," Assignments, and
Category Totals are checked by default.

. Click the Data To Include menu again to close it

. To include students’ grades from the current term, use the

default settings under Date Range
Scroll to the top of the page and click the Format tab

Since you are including all of the available data in the
report, leave the page orientation set to Landscape to
make the text easier to read

Use the default option PDF for the report output

To create a page break between students, check Page
Break

Choose to exclude row shading to save ink during printing
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18.

19.

20.

To run

oa B~ W N

10.
11.
12.

Leave the “Include” check box clear for the Top Note option,
since you don’t plan to include a note at the top of the
report

Leave the “Include” check box clear for the Bottom Note
option, since you don’t plan to include a note at the bottom
of the report

To generate the report, click Run Report
the Student Roster report for a class:

Open the menu at the top of the gradebook window and
select a class

Click Reports
Select Student Roster
Enter a report title, such as Field Trip Roster

Since you selected a class before you navigated to the
Reports menu, it is already selected for the Classes option

Verify that the report applies to all of the students in the
selected class

To sort the roster of students by last name, open the
Students menu and choose Last Name

Add columns of student information by opening the Add
Columns menu and clicking Add next to Gender and Grade
Level

Click Add next to Blank twice to include a column for taking
attendance and one for tracking participation

A column titled “Name” is included by default to list the
students’ names.

Click the Add Columns menu again to close it

Enter Attendance as the title of the first blank column

Enter Participation as the title of the second blank
column

13. Scroll to the top of the page and click the Format tab
14. Open the Orientation menu and choose Portrait
15. Use the default settings for the rest of the format options

16. To generate the report, click Run Report

Field Trip

Name Gender Grade Attendance Participation
AYALA, Frank M 12

BAILEY, MacDonald M 12

BERGER, Harvey M 12

CASE, Shaniqua F 12

CASEY, Headroom F 12

CLINE, Matt M 12

COBB, Hunter F 12

FRIEDMAN, Bennet F 12
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